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Colligo Engage Outlook App

CoLLIGO ENGAGE OUTLOOK APP

Welcome to Colligo Engage Outlook App, the simple, powerful, and reliable solution to enterprise email
management in Microsoft SharePoint. Featuring seamless integration with Microsoft Outlook, Colligo
Engage Outlook App makes it fast and easy to file, tag, find, view, sync and share email and attachments
in SharePoint, all from within the familiar Outlook interface.

Colligo Engage Outlook App streamlines SharePoint interaction by providing simple, intuitive ways to
move or copy email and attachments to SharePoint from Outlook, including drag-and-drop or send-and-
file. Email metadata is automatically captured for findability, and additional metadata can be easily
added to classify content according to corporate guidelines or regulatory requirements. The integrated
search functionality searches both SharePoint and Outlook to locate emails, or find documents to send
as attachments. SharePoint sites can also be viewed from within Outlook, making finding content a
breeze.

Colligo Engage Outlook App also encourages users to file emails and attachments to SharePoint in the
office or on the road, and allows mobile and remote workers to remain productive, regardless of network
latency or unavailability.

Benefits

e Empower users to easily manage email & documents in SharePoint

¢ Increase the quantity of content captured & tagged in SharePoint

e Reduce risk, improve compliance & records retention

¢ Reduce uncontrolled content in personal archives and PSTs

e Make SharePoint accessible in the applications users use every day, everywhere

e Improve collaboration, document & project management

o Drives user adoption of SharePoint by improving ease of use

o Encourage users to file emails and attachments to SharePoint in the office or on the road

¢ Allow mobile and remote workers to remain productive, regardless of network latency or unavail-
ability

Key Features

o File—Drag-and-drop email and attachments to SharePoint within Outlook, using the familiar Out-
look folder tree. Send & File button automatically files sent email to SharePoint.

e Tag—Add automatic or customized metadata, including managed metadata.

¢ Sync—download SharePoint content for offline viewing and editing. File emails even when dis-
connected from the network.

e Find —Search Outlook and SharePoint together. Find your content no matter where it lives.

¢ View —See SharePoint content right inside Outlook. No need to switch to the browser.

¢ Share - Email attachments as links for easy collaboration.

o Deploy - Deploy easily, client-only installation.

Platforms Supported
e Microsoft Outlook 2007, 2010 SP1, or 2013 (32-bit or 64-bit edition)
Microsoft SharePoint 2007, 2010, or 2013
Windows Vista, Windows 7, or Windows 8
Internet Explorer 7, 8, or 9 (optional)
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NOTE: The screenshots in this document use Outlook 2013, SharePoint 2010, and Windows 7. Your user
interface may differ depending on your specific configuration.
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INSTALLING AND ACTIVATING COLLIGO ENGAGE OUTLOOK APP

Collig

o Engage Outlook App can be installed in one of two modes. Before you install Colligo Engage

Outlook App, ensure that you have chosen the correct mode; if you want to change modes, you will

need

to uninstall and reinstall the program.
Connected: If you install Colligo Engage Outlook App in Connected mode, you do not have the abil-
ity to synchronize content so it is available for viewing and editing offline; you can only access your
SharePoint content when you are connected to your SharePoint server. NOTE: SharePoint 2007 is
not supported in Connected mode.

NOTE: This user guide addresses Colligo Engage Outlook App Offline mode only.

Offline: If you install Colligo Engage Outlook App in Offline mode, you have the ability to syn-
chronize content so it is available for viewing and editing offline; your SharePoint content is avail-
able to you even if you are not connected to your SharePoint server.

To install and activate Colligo Engage Outlook App:

1. Double-click to open the Colligo Engage Outlook App XX.zip file and extract the contents.
2. Inthe folder, double-click the folder that corresponds with your operating system:
a. x86: choose this option if you have a 32-bit operating system
b. x64: choose this option if you have a 64-bit operating system
4. Double-click Setup.exe.
5. Follow the steps in the install wizard.
6. Afterinstallation is complete, enter your information to activate the software. If you do not activate
Colligo Engage Outlook App, it does not display.
7. Ifyou are unable to connect to the activation server, the following error message displays:
r(? Collige Engage [lﬁf
Te complete your installation, please complete the fields below and click
Activate. Your privacy is important to us, and your personal information will
never be shared with third parties.
Marme: David Jackson
Crganization: Firestarter
Email address: djackson@firestarter.con{
&3 Unable to connect to the activation server. Please try again later
or activate by email.
[ Activate || Activateby Email |[ Bt |
NOTE: The inability to connect could be due to firewall settings in your corporate network or a
dropped internet connection. If the connection issue is temporary, Colligo advises to attempt
activating at a later time before trying activation by email.
8. Click Activate via Email.
9. On the following screen, click Export Activation Request.
10. Save the ActivationRequest.txt file in your preferred location.
11. Attach this file to your email and send to activation@colligo.com.
You will receive a response from Colligo Technical Support with instructions for manual activation.
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After Colligo Engage Outlook App is installed, a new group called Colligo Engage displays in the left-

hand pane in Microsoft Outlook:

4 Favorites
Inbox
Sent Items

Deleted Iterns 814

4 Colligo Engage
Deleted Items
Browser

I+ Favarites

I Folders

I Recovered Items

Search Folders

You can now add SharePoint sites and designate folder locations for your Favorites and Folders lists.

Checking for Updates

To check if you are using the most current version of Colligo Engage Outlook App, click the Colligo drop-

down arrow and select Check for Updates.

The www.colligo.com site launches in your web browser. If there is a newer version available, click the

Download the latest version now link to install the newer build.

Updating Your License Key
To change your license key:
1. Click the Colligo drop-down arrow and select Install License Key.

The Enter License Key dialog displays:

(? Enter License Key

Please enter your 25-digit license key (include dashes):

Cancel |

2. Enter your license key and click OK.
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CONNECTING TO COLLIGO ENGAGE CONSOLE

If your solution includes Colligo Engage Console, the prompt displays when you are connected:

@ Colligo Engage Console g

Please enter your Colligo Engage credentials:

User name: | | |

Password:

Forgot Password?

[ CK I [ Cancel

. 4

Enter your User name and Password and click OK to connect.

If you have forgotten your password, click Forgot Password?

I Colligo Engage

A password reset request has been submitted. A temporary password has been
sent to your registered email address,
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MANAGING SHAREPOINT SITES

Colligo Engage Outlook App lets you connect to SharePoint sites through Outlook. You can add, edit,
and remove sites, as well as add folders to your Favorites and Folders lists.

Adding a SharePoint Site in Colligo Engage Outlook App
You can add a SharePoint site to Colligo Engage Outlook App in one of two ways:

1. By using the SharePoint Sites dialog in Outlook.
2. By using the Connect to Outlook App button in Internet Explorer.

Using the SharePoint Sites Dialog in Outlook
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.

The SharePoint Sites dialog displays:

7 S
© Colligo Engage Configuration [éJ

SharePoint Sites iz SharePoint Sites
Favorites o Add Remove Edit !
Folders

Add SharePoint Site

Search Lecations
Search Options
Launchpad

Settings

Close |
2. Click the Add SharePoint Site link or the Add icon.
The Add SharePoint Site dialog displays:
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' B
(F) Add SharePoint Site [

URL:

Examples: http://server/workspace
https://secureserver/workspace

Server Authentication

Authentication Type: |Auto-detect b

Auto-detect

@ Use default crq Windows Classic

%) Use the follow Windows Claim-based l
Form-Based

User name: | ADES 2.0

Office365

Office365 by Prompt

Domain CORPORATE

Password:

[ OK I[ Cancel |

L 4

3. Enter the following information in the dialog:

a. URL: enter the web address of the SharePoint site you want to add. You can type or
copy-and-paste the address, or drag-and-drop an address from Internet Explorer into
the field.

b. Server Authentication

¢ Authentication Type: choose one of the following options

o Auto-detect

e Windows Classic

e Windows Claim-based

e Form-Based

e ADFS 2.0

o Office365

o Office365 by Prompt
¢ Use default credentials: select this option to choose default Windows credentials
« Use the following credentials: select this option to enter user-specific credentials

and enter the following information:

e Username

e Password

e Domain

4. Click OK. The site displays in the list. You can expand the site to see the subfolders:
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(f Colligo Engage Configuration =
SharePoint Sites & SharePoint Sites
Favorites o Add Remove Edit ]
Folders

Collige Intranet

Search Locations Firestarter Portal

Marketing
Search Options Social
Launchpad
Settings

Close

After adding your sites, you need to determine which libraries/folders are going to be upload-only or
offline locations. For more information, see Setting Folders as Upload-only or Offline.

Using the Connect to Outlook App Button in Internet Explorer
You can add a SharePoint site or library to Colligo Engage Outlook App directly from Internet Explorer
using the Connect to Outlook App button.
To add a site with the Connect to Outlook App button:
1. Navigate to the SharePoint site or library that you want to add to Colligo Engage Outlook App and
click the Connect to Outlook App button:
Internet Explorer 9:

=

@ http://ws-sp2010/5itePages/Home.aspx
File Edit View Favorites Tools Help

& B = @ * Page~ GSafety~ Tocols~w '@" @)

Connect to Collige Engage

Colligo Intranet - Home

Site Actions + il Erowse

NOTE: If the Connect to Outlook App button is not visible, you need to enable the Command bar.

2. Ifyou are logged in with your default credentials, you are not prompted for a username and pass-
word.
If not, you are prompted for your login credentials with the Connect to Outlook screen:

3. Enter your login information and click Continue.
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The following screen displays.

Colligo Engage: Connect to Outlook

Connect this SharePoint location to Outlook:
http:/fvs-dev-sp2 010/5teveTest/Shared%
20Documents/Forms/Allltems.aspx

Add as Favorite in Engage

A Favorite is a lecation you frequently use to file email. ]
Selecting this option will add the SharePoint location ta 4 [ Favorites
Cutlook as shown here, Any sub-folders are not visible [ New Favarite
within Favorites.

-
4 Colligo Engage

"

[C] Add as Folder in Engage

A folder is used to represent a SharePoint document library

-
4 Colligo Engage

or folder. Selecting this option will add the SharePoint 4 [0 Favorites
lacation to Cutlook as shown here. All SharePoint sub- 4 7 Folders
folders within this library or folder will also be visible in 4 7] Mew Folder
Cutlook. £3 sub-folder
Y -
[ Continue | [ Cancel |

4. Check the Add as Favorite in Engage boxto add the location to your Favorites list.
If you are adding a site-level location, the option to add it as a Favorite does not display.
5. Check the Add as Folder in Engage box to add the location to your Folders list.

When the connection is complete, the site or library now displays in your SharePoint Sites list and,
depending on which boxes you checked, your Folders and/or Favorites list in Colligo Engage .

Enabling the Command Bar in IE 9

In Internet Explorer 9, the Command bar is disabled by default. To see the Connect to Outlook App
button, the Command bar must be enabled and visible.

To enable the Command bar:
1. Right-click in the white space at the top of your browser window:

6[ _.'| http://vs-sp2010/PM/SitePages/Home.aspx?RootFo O ~ & X H Product Management - Ho... - ——

File Edit View Favorites Tools Help
Menu bar

Site Acti i Browse Favorites bar

Command bar
v Status bar
Snagit

(@ COII'SO Collaboration Made Easy.™ Product Management » Home
Networks

Colligo Intranet site for the Product Management de

v Lockthetoolbars

Home  AdminTest  Document Workspace — Records Demo Show tabs on a separate row

2. Select the Command bar option.

The Command bar displays at the top of your browser.
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Removing a Site

To remove a site from the Colligo Engage group:
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in

Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. In the SharePoint Sites list, click the site you want to remove and click Remove.

A dialog asks for confirmation of the deletion.

NOTE: Removing a site removes all search locations, favorites, folders, and history items referencing
the site.
3. Click OK to continue with the removal, or Cancel to retain the site.
If you remove a site, any offline content that has not been synchronized is deleted. To recover any of this

content, please contact your administrator.

Editing a Site
To edit a site in the Colligo Engage group:
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe SharePoint Sites list, click the site you want to edit and click Edit.
The Edit SharePoint Site dialog displays.
3. Edit the fields as necessary. See Adding a SharePoint Site in Colligo Engage Outlook App for a

description of the fields.
4. Click OK.

Refreshing a Site

To refresh a site in the Colligo Engage list:
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.

2. Click on the site you want to refresh and click the Refresh icon: .

NOTE: you can also refresh a folder by right-clicking on a folder under either your Folder list or
Favorites list in Outlook and selecting Refresh from the contextual menu
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MNew Folder...

*  Move Down
Rermowve this Favorite
Don't Prompt for Properties
Add as Folder

Rename...

Refresh
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CONFIGURING LOCATIONS FOR EMAIL FILING

After you have added your sites, you now need to determine which folder locations are upload-only or
offline. You can also set them as Folders and Favorites.

Setting Folders as Upload-only or Offline

You have the option to set your libraries/folders as either upload-only or offline. If you set a
library/folder as upload-only, the contents of those locations are only available to you when you are
connected to your SharePoint server. If you are not connected, the content is not available to you for
viewing or editing.

If you set a library/folder as offline, the folder structure and the content of the offline location is
downloaded to your machine for offline viewing and editing purposes. The contents of those locations
are downloaded to your local machine and you are able to access the content at any time, regardless of
whether you are connected to your SharePoint server or not.

If you do not set a library/folder as either an upload-only location or offline location, you will not be able
to file any emails, attachments, and other content from Colligo Engage Outlook App to SharePoint.

These settings are applied at the folder level; you cannot apply this setting to an entire site or sub-site.

NOTE: your administrator may have disabled the option to set a folder as offline. If this is the case, the
option is greyed out.

Setting a Location as Upload-only

Any location set as upload-only is marked with the following icon: Ce
All subfolders within an upload-only location are also set as upload-only.

Use one of the following three methods to set a folder location as upload-only:

1. Select asite to display any sub-sites or document libraries.
2. Double-click the library/folder you want to set as upload-only.

The folder structure of the location downloads.

OR

1. Select a site to display any sub-sites or document libraries.
2. Right-click the library/folder you want to set as upload-only and select the Set as upload-only
option from the menu.

The folder structure of the location downloads.

OR

1. Select a site to display any sub-sites or document libraries.
2. Select the library/folder you want to set as upload-only.

3. Click the Sync Settings icon and select Set as upload-only:
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Gf Colligo Engage Configuration @
SharePoint Sites 5 SharePoint Sites
= | 2 Add | = Remove | Edit | B J |
Folders 4 Firestarter Portal I Cq Setas upload-only
Search Locations Marketing C$ Setasoffline
Sales
Search Options E_j Finance
E_j Form Templates
Launchpad E_j m
Settings E_j Manufacturing
E_j Marketing
[ Sales

Setting a Location as Offline

After you set a library/folder location as upload-only, you can choose to make it an offline location if you
want the content in that location to be downloaded to your machine for offline editing and viewing
purposes.

NOTE: your administrator may have disabled the option to set a folder as offline. If this is the case, the
option is greyed out.

Any location set as offline is marked with the following icon: All subfolders within an offline location
are also set as offline.

Use one of the following two methods to set a folder location as offline:

1. Select asite to display any sub-sites or document libraries.
2. Right-click the library/folder you want to set as offline and select the Set as offline option from the
menu.
OR

1. Select a site to display any sub-sites or document libraries.
2. Select the library/folder you want to set as offline.

3. Click the Sync Settings icon =

(Fj Colligo Engage Configuration Iﬁ
SharePoint Sites = SharePoint Sites
Favorites | BAdd [ Remove [ 4Edit| 33 | ¥ 01 J
e 4 Firestarter Portal , C# Setas upload-only
Search Locations Marketing | Et Set as offline
Sales
Search Options E_j Finance
E_j Form Templates
Launchpad E_jl'l'
Settings E_j Manufacturing
E_j Marketing
E_j Sales
5 Citn Arccie
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Making a SharePoint Location a Folder or Favorite

After you have set your folder locations as upload-only or offline (see Setting Folders as Upload-only or
Offline), you can then add your most frequently used SharePoint folder locations to either the Favorites
or Folders group in your Colligo Engage group in your Outlook Folder Tree. If you have not set a folder
location as either upload-only or offline, making it a Favorite or Folder automatically sets the location as
upload-only .

The purpose of setting a location as a Folder or Favorite is to provide a shortcut in your Outlook Folder
tree to that location. Then you can easily drag-and-drop emails, attachments, and other items into these
locations from within Outlook.

When you mark a SharePoint location as a Favorite, it is a link to that location only; if there are any
subfolders underneath that folder, you cannot navigate to them in the list. If you want to add a top-level
folder and its subfolder, you need to add them separately.

When you mark a SharePoint location as a Folder, you are adding the folder and any subfolders it
contains. If you want to move or copy an email to a folder in your Folders list, you can navigate through
the subfolders to the location where you want to file your email. This differs from locations in your
Favorites list, which do not include the folder hierarchy.

Adding a Location as a Favorite
You can add a SharePoint location to your Favorites list in one of two ways:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. In the SharePoint Sites list, select the site and the folder within the site that you want to add to

your Favorites or Folders list and click the Add Favorite icon: |:I
3. Ifthelocation is not already set as upload-only or offline, it automatically synchronizes and
becomes an upload-only location.

The folder displays with the chosen icon beside it:
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(ff Collige Engage Configuration

[S)

SharePoint Sites
Favarites

Folders

Search Locations
Search Options
Launchpad

Settings

= SharePoint Sites

@ Add Remove Edit (o] D /

4 Firestarter Portal
Marketing
Sales
E_j Finance
E_j Farm Templates
Em
E_j Manufacturing
4 g Marketing
E? Brochures
Ei Campaigns
E? Datasheets
Ei- Graphics
C# Market Research 7.7
Ei- Proposals
03 Strategy
E_j Sales
E} Site Assets
E_j Social
[ Style Library

Close

NOTE: ifa syncis in progress, you can close the Configuration window without cancelling the sync.

OR

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Favorites.

The Favorites dialog displays:
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=
(‘: Colligo Engage Configuration

SharePoint Sites
Favarites

Folders

Search Locations
Search Options
Launchpad

Settings

. Favorites

© Add Remove

Prompt

Add Favorite

Close

o

3. Click the Add Favorite link or the Add icon

The Add Favorite dialog displays.

4. Browse to the location of the folder you want to add to your Favorites list, and click OK.

NOTE: if you right-click Favorites under the Colligo Engage list, you can select Add Favorite from the

contextual menu and the above dialog displays.

Any folders added display under Favorites in the Colligo Engage list:

4 Colligo Engage

Deleted Itermns

Browser

4 Favarites

Graphics (firestarter.sharepoint.co...

Marketing (firestarter.sharepoint.c...

Folders
Recovered Items

Search Folders

You can now use the folders to view, upload, and download your SharePoint files. Click on a folder to

view its contents:
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4 Favorites
Inbox a =
Qutlook  Calendar OneDrive  Sites B s 7
Sent ftems. .
Deleted Items 835 -~ a
BROWSE | FILES  LIBRARY O SHARE Yy Fouow O
Firestarter Porta Firestarter Marketing Firestarter Sales # EDIT LINKS Search this site v P
e oz Marketing » Graphics
Deleted Items
Browser
4 Favorites Home ®new Fupload @sync Aedit #manage & share
Graphics (firestarter.sharepoint.... m
aphics Epoint.. 4ll Documents  Flat  Item Count ==+ Find a file £
Marketing (firestartersharepoint.c... Finance
Folders Drag files here to upload
Manufacturing _ )
Recovered ltems v O Name Modified Maified By Author  Related Company  Person/Group  Product  Published
Marketin .
Search Folders 2 Logos w September 19,2013 [ David Jackson
Sales. .
firestarter - September 19, 2013 David Jackson
Social
R firestarter_blue s March 05 David Jackson Yes
Campaign Tasks
Fent Schedule firestarter blue_sm ... September19, 2013 [] David Jackson
Staff Directory firestarter_purp «w  September 19, 2013 David Jackson
Vacation Tracking firestarter_purp_sm « September 19,2013 [ David Jackson
firestarter_sm - September 19, 2013 David Jackson
# EDITLINKS
firestarter_sm_purp v September 19, 2013 1 David Jackson
[=  Helen Jones_090ct13 10.11.45_logo - October 09, 2013 David Jackson Excite;
image

NOTE: you can also add a folder to your Favorites list by right-clicking on a folder under the Folders
list and selecting Add as Favorite from the contextual menu:

Mew Folder...

EM oo

L= -

2] SortSubfolders Ato Z

& Maove Up

*  Move Down

Remuove this Folder

Add as Favorite

Rename...

Refrezh

Prompting for Properties

For locations that you have added as Favorites, you have the option to turn the prompt for the Edit
Properties dialog on or off:
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- ™y
(©) Edit Properties E@g
Options
Content Type: | Email A
Properties
Name Value =
= Name 010ctl4 23.21.01_Djackson@firestarter.onmicre msg
Title Djackson@firestarter.onmicrosoft.com
Subject Djackson@firestarter.cnmicrosaft.com
From Helen Jones £

From-Address

Sent 10/1/2014 11:21 PM

Received [10/1/2014

To

To-Address

cC

CC-Address

BCC

BCC-Address

| OK |[ Cancel ]

Colligo Engage Outlook App

This prompt is enabled by default. You can turn it on or off in one of two ways:
e Inthe Favorites tab, select the location you want to disable the property prompt for, and click the

Prompticon: E
OR

e Inthe Favorites group in the Outlook folder tree, right-click a location and select either Don't
Prompt for Properties or Prompt for Properties from the contextual menu:

Mew Folder...

*  Move Down

Remowve this Favorite

Don't Prompt for Properties
Add as Folder

Rename...

Refresh
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Removing a Location from the Favorites List
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Favorites.

The Favorites dialog displays.

3. Select the folder you want to remove and click Remove.

The folder is removed from your Favorites list and from the Colligo Engage section in your Outlook
Task Pane. However, the SharePoint location itself still remains marked as an upload-only location.

NOTE: you can also remove a Folder from your Favorites list by right-clicking the Folder in your
Favourites list in Outlook and selecting Remove this Favorite from the contextual menu:

MNew Folder...

w  Move Down

Remove this Favorite

Don't Prompt for Properties
Add as Folder
Rename..

Refresh

Adding a Location as a Folder
You can add a folder to your Folders list in one of two ways:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. In the SharePoint Sites list, select the site and the folder within the site that you want to add to

your Folders list and click the Add Folder icon: I:l
3. Ifthelocation is not already set as upload-only or offline, it automatically synchronizes and
becomes an upload-only location.

The folder displays with the folder icon beside it:
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- [y
@,‘- Colligo Engage Configuration ﬁ

SharePoint Sites & SharePoint Sites

Favorites ©Add (o Remove [L#Edit o] L?lr:l /

Folders

4[] Firestarter Portal
L) Marketing
Ll Sales
Search Options E__H Finance
E__H Form Templates
Ey
E__H Manufacturing
4 [ Marketing 77 [
E? Brochures
Ei- Campaigns
E? Datasheets
E? Graphics [
E? Market Research
E? Proposals
03 Strategy
E__H Sales
E__H Site Assets
E__H Social
[ Style Library

Search Locations

Launchpad

Settings

Close

NOTE: ifa syncis in progress, you can close the Configuration window without cancelling the sync.

OR

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Folders.

The Folders dialog displays:

r@,‘- Colligo Engage Configuration ﬂ
SharePoint Sites ] Folders
Favorites B Adct B Remove
Folders

Add Folder

Search Locations
Search Options
Launchpad
Settings

\
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3. Click the Add Folder link or the Add icon.
The Add Folder dialog displays:

oo I =

Selected location: Home

OK H Cancel l

NOTE: if you right-click Folders under the Colligo Engage list in Outlook, you can select Add Folder
from the contextual menu and the above Add Folder dialog displays.

4. Browse to the folder you want to add to your Folders list and click OK.
Any folders added display under Folders in the Colligo Engage list:

4 Colligo Engage
Deleted Itermns
Browser

[ Favorites

4 Folders

I» Graphics (firestarter.sharepoint.co...

I Marketing (firestarter.sharepoint.c...

Recovered Items

Search Folders

NOTE: you can also add a Folder by right-clicking on a folder under your Favorites list and selecting
Add as Folder from the contextual menu:
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MNew Folder...

*  Move Down
Remowve this Favorite

Don't Prompt for Properties

Add as Folder

Rename...

Refresh

NOTE: as a best practice, it is recommended that you do not add folders with more than 50
subfolders to your Folders list, as they will take a long time to populate and refresh. If there is a top-
level folder that has a number of subfolders to which you frequently file emails, it is recommended
that you use the Move or Copy buttons and browse to the SharePoint location, rather than using
the Folders list in your Outlook pane.

Removing a Location from Folders List
1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Folders.
3. Select the folder you want to remove and click Remove.
The folder is removed from your Folders list and from the Colligo Engage section in your Outlook
Task Pane. However, the SharePoint location itself still remains marked as an upload-only location.

NOTE: you can also remove a folder by right-clicking on a folder under the Folder list in Outlook and
selecting Remove this Folder from the contextual menu:

Mew Folder...

P
—

Sort Subfolders Ato £

*  Move Down

Remowve this Folder

Add as Favorite
Rename...

Refrezh
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Renaming a Favorite or Folder

When you have a location added as a Favorite or a Folder, you can right-click a location and select
Rename:

Mew Folder...

51 Sort Subfolders Ato £

w  Maove Down
Remuowve this Folder

Add as Favorite

Rename...

Refrezh

The Rename Favorite or Folder dialog displays:
If Rename Favorite or Folder lﬂ

Pick a new name for this location:

@ Shared Documents (vs-sp2010)
Shared Documents (Colligo Intranet)
Shared Documents (hitp:/fvs-sp2010)
http:/fvs-sp2010/5hared Documents
Calligo Intranet : Shared Documents

Shared Documents

I OK I[ Cancel ]

The dialog offers you a number of options, as well as a blank field to enter your own custom name for the
location.

Choose an option and click OK.

If you have chosen one of the predefined options, the following dialog displays:
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:] Apply naming pattern to all unmeodified locations?

v || No

Choose Yes or No as preferred.

Viewing Upload-only Locations

Colligo Engage Outlook App

Once your SharePoint locations have been set as either a Favorite or Folder, you can select the location

in the folder tree to display the content.

If you have set a location as upload-only, the content of the SharePoint location displays in the Outlook

interface as follows:

4 Favorites = 2

Inbox

Sent Items

Deleted Items 835 ’_‘

BROWSE FILES LIBRARY
17| DESTA RTED) Firestarter Marketing  Firestarter Sales #' EDITLINKS

ALl Marketing » Graphics

Deleted Items

Browser
4 Favorites Home

Graphics (firestarter.sharepoint... m et ttem et o

Marketing (firestarter.sharepoint.c.

Folders

Recovered ltems v 0
SrdhlElizs Logos .. September 19,2013 [ David Jackson
Sy firestarter .. September19,2013 [ David Jackson
Socia
) g frestarter_blue - March 05 David Jackson
Campaign Tasks
Cent Schedule = firestarter blue_sm .. September19,2013 [ David Jackson
staff Directory g frestarter_purp . September19,2013 [ David Jackson
Vacation Tracking = firestarter_purp_sm .. September19,2013 [ David Jackson
= firestarter_sm .. September19,2013 [ David Jackson
# EDITLINKS
= firestarter_sm_purp . September19,2013 [ David Jackson
{3 Helen Jones_080ct13 10.11.45_logo - October 09, 2013 David Jackson

image

B
-

) sHARE Y% Fouow T

Search this site h ol

Excite;

NOTE: for upload-only locations, you cannot view any content when you are offline.

If a location is set as upload-only, the SharePoint content that displays looks exactly like the content
would in an Internet browser window. You can browse through the site and use typical SharePoint
functionality like opening a document in a program, checking an item in or out, renaming, or deleting an
item. Any changes you make to an item are reflected immediately in the SharePoint site so other users

can see them.

For more information, see Editing Content in Colligo Engage Outlook App

Viewing Offline Locations

Once your SharePoint locations have been set as either a Favorite or Folder, you can select the location

in the folder tree to display the content.
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If you have set a location as offline, the content of the SharePoint location displays in the Outlook
interface as follows:

o SE] = Marketing (firestarter.sharepoint.com) - Colligo Engage - Outlook 7 EH - O X
HOME SEMD / RECEIVE FOLDER VIEW COLUIGO LAUNCHPAD
El l._|"j I'~ - Search Move Unread/ Read Siirch People
- * - - “ @) Colligor S Rules - - fiz EE Address Boak
New  MNew - Delete | Reply Reply Forward =l - —|  Move Copy §
Email Items- &57 All Team Email . OneNote Follow Up Y Filter Email -
Mew Delete Respond Quick Steps ) Colligo Engage Maove Tags Find ~
< -
4 Favorites Flresmlr;er P?nal > Marketing
Inbox Marketing
Sent Items Mew - | Upload - | Filter = view:  All Documents -
Deleted Ttems 835 Name Modified Modified By Author  Related Company  Person/Group Product  Published
E‘ Brochures 915/2013 9:33 AM Mary White
E‘ Campaigns 9/19/2013 9:38 AM Mary White
b TMacKinnon@colligo.com [# patesheets 9/19/2013%:38 AM  Mary White
E‘ Graphics 9/19/2013 10:35 AM  David Jackson
4 Colligo Engage O Market Research  9/19/20139:37AM  Mary White
Deleted ems Et Proposals 9f19/2013 9:38 AM Mary White
. Nk
S C$ strategy 9/19/2013 ::37AM  Mary White
I» Favorites
4 Folders
[» Graphics (firestarter.sharepoint.co...
Marketing (firestarter.sharepoin...
Recovered ltems
Search Folders
Mail Calendar People Tasks -

If a location is set as offline, you can open, view, and edit the content as you would if the content was
online. The difference is that any changes you make are not reflected in the SharePoint site itself until
you are connected to the SharePoint server again, and you synchronize the site.

Viewing Content in Outlook View

You have the option of displaying your SharePoint content in Outlook view, which means your content
displays as if the items were emails. See Managing Settings for information about configuring your view.

If you choose this option, your content displays as follows:
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B = L = Social (firestarter.sharepoint.com) - Colligo Engage - Outlook 7 @H - O X%
HOME SEND / RECEIVE FOLDER  VIEW COLLIGO LAUNCHPAD
= ".:| x E:'I ﬂi:,l t:" ? Mark as read |l—'§ Copy to: Advan. [ {ﬁ Psearch | ¥ - [7] =l |> Search People
s 7% Clean Up ~ € =4 “PM E3 To Manager - @) Colligo ~ =1 [EE Address Book
Mew  New Delete  Reply Reply Forward [ . Move Copy Move Rules Unread/ Categorize Fallow
Ermail ltems~ | & Junk- T EE More E1 Team Email v Done 2 o o . Read s Up- 7 Filter Email -
New Delete Respond Quick Steps ] Colligo Engage Move Tags Find ~
<
All Unread | search Sacial (firestarter.sharepoint.com) (Ctrl=E] Current Folder = o -
Glascntes & ! ! P e Ben Henderson (Demao) 060ct14 S
Inbox 1 D@ |FROM SUBJECT SIZE 4 - Last changed:  October 6, 2014
Sent ltems 4 Date: Today
Deleted ltems 1 |1 David Jackson SP¥am on Yammer_21Mar14 18.57.29_Top conversations for you this w... 2KE

David Jackson Spiceworks_24Mar14 17.02,05_Cloud-based file sharing - get your live ... 3 KB

Mon 2014-10-06 11:50 PM
+ BHendersanz@colligo.com 1 David Jackson Nick Sawadsky_16Jan07 23.57.49_RE Proposed protacal format.eml 2KB
s A\
4 Coliigo Engage ]  David Jackson Microsoft Canada_27Mar07 15.08.20_Your Microsoft Office 2007 syste... 3 KB Ben Henderson (Demo)
Document for approval
Deleted ltems |1 David Jackson Jerry McKenzie_185ep13 21.11.32_background material.eml 2KB
Browser [ | David JacksonIT Mews Daily_21Mar14 12,37.00_Remembering Pat McGovern, the tech.., 3 KB To Ben Hendersar (Deme)
Eoprs . Attachments B2 FinalPlan.xisx
| David Jackson Dave Mackay_23Aug13 15.49.23_ no subject .eml 2KB
4 Folders
Ermils (firestarter.sharepaint.com... ]  David Jackson Dave Mackay_224ug12 22.49.32_Latest Contoso Agreement.eml 2kB
4 Social (firestarter.sharepoint... [16] T David Jackson Colligo Sharepoint RETURN €01 -14.pdf 2KB Hi,
b Testing 4 David Jackson CAMP IT Conferences_10Mar14 12,09.23_Meet w Midwest Enterprise M... 3 KB -
b Recovered ltems Please see the attached final plan document for your
4 David Jackson Ben Henderson (Demo)_060ct14 23,49.34_Document for approval.msg 2 KB approval.
Search Folders
|1 David Jackson Argyle Executive Forum_27Mar07 19.00.00_Oprah CFO, Godiva, Eli Lilly... 3 KB Thank
anks.
4 David Jackson 3Bureaubonitoring_10Mar14 14.55.39_TransUnion Experian Equifax R... 22 KB
4 Date: Older
1 David Jackson Note Taking.pages.zip 102 KB -
Mail Calendar People Tasks -

ITEMS: 16

Note: After enabling you need to select a new folder within the Colligo PST to view the new mode.

When you select a folder, the list of contents within the location is displayed in the list pane. The
information displayed in the Outlook columns are:
e lcon: Theicon of the item
e From:The name of the person who uploaded the item (this may not be the same as the person
who last edited the file)
e Subject: The SharePoint File Name of the item
o Size: This is initially the size of the stub holding the metadata, but once clicked on it will display the
size of the item.
If you are using Outlook 2013 you can add the column Received to the view. This displasy the date and
time the item was uploaded to SharePoint. By default, although this isn't shown, Outlook sorts by this

column. The addition of the column is lost the next time Outlook restarts and Colligo Engage builds out
the view.

To edit items in this view right click the item and select Open. This opens the item directly from
SharePoint. Any edits to the items are saved directly or synced later to SharePoint. It may take some
time to update the preview of the item in Outlook after an edit has occurred on an item.

To reply or forward an email, right-click and select Open , then select the Reply or Forward button in the
ribbon of the email.

The Outlook search box will search the metadata of any items in the list view, and search the content of
any items that have been selected and have been previewed. From a more advanced search use the
Colligo Search pane by clicking on the Search button in the Colligo Engage ribbon.

Viewing Item Version History

If a library has versioning enabled, you can view an item's version history by choosing the Version
History option in the right-click contextual menu:
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MName Modified Modified By Author  Related Company  Person/Group  Prod
E FireStarter Pro Range datashee... 3/5/2014 4:02PM David Jackson Pro
T3 EdtPropertes...
B Open with Adobe Reader
Copy
Paste
[ checkout

|@ Wersion History

Send As Link
Send As Attachment

@, Copy SharePoint URL

@, Copy SharePoint Doc ID URL

Rename

2 Delets

Create Shortout

< 1 | »

NOTE: this feature is enabled only when you are connected to your SharePoint server. If you are offline,
the option is greyed out.

The Version History window displays:

No Modified Maodified By Size Comments
04 2014-09-12 9:45 Rick Ramsay 18 KB
03 2014-09-10 6:02 Rick Ramsay 18 KB
02 2014-08-105:12 Rick Ramsay 35 KB
01 2014-08-13 5:29 Rick Ramsay 35 KB

Click on a version number to open the SharePoint version of the item.

2/25/2015 Copyright 2015 Colligo Networks, Inc. All rights reserved. Page 27 of 66

Not to be reproduced without permission. Learn more at www.colligo.com.



Colligo Engage Outlook App

SYNCHRONIZING CONTENT IN COLLIGO ENGAGE OUTLOOK APP

If you are using Colligo Engage Outlook App in Offline mode, you may need to synchronize your content
from time to time.

If you have set a folder location as offline and made changes to items while you are disconnected from
your network and SharePoint server, you need to synchronize those changes when you are once again
connected to your network and server. You can synchronize your content using the Colligo Engage Sync
Panel, which is a separate, stand-alone part of the Colligo Engage Outlook App interface:

rf Colligo Engage Sync Panel l == ﬂhr
File Site View Help
Sync Issues
Issue Ttem Site List Folder
‘ o
© o Synchronization Activity

From this dialog you can view any Sync Issues, set your synchronization settings, set default metadata
for folders, and view any pending changes.

Setting Synchronization Options
1. From the View menu, select Options.
The Colligo Engage Options dialog displays:
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Collige Engage Options [—EhJ

l

Storage

Storage location
|C: \Users\tmackinnon\AppData'Local\Coligno:  Browse...

Synchronization

[+ synchronize on startup

[+ Synchronize when list is viewed

[+ Enable combined chedk-in and sync

[¥ Enable background synchronization

Background synchronization interval: ’30_ minutes

v Automatically download lists to resolve Site Column values

Cancel ‘ |

LS &

2. In the Synchronization section, choose your preferred options:

¢ Synchronize on startup: choose this option if you want your lists and libraries to synchronize
every time Colligo Engage Outlook App starts

¢ Synchronize when list is viewed: choose this option if you want your lists and libraries to syn-
chronize every time you view a list or library

o Enable Combined check-in and sync: choose this option if you want to both check an item in and
sync it at the same time. If this option is not checked, the item remains checked out after the sync.

« Enable background synchronization: choose this option if you want to set the synchronization to
happen in the background on a time-specific basis, and enter your preferred time interval

o Automatically download lists to resolve Site Column values: if you have lists that reference
other lists (look-ups), checking this option ensures the related referenced lists are also down-
loaded

NOTE: Depending on how your IT Administrator has configured the installation, this dialog may not be
accessible to you, or the synchronization options may be greyed out.

Synchronizing Sites Manually

After you have added your sites, you may want to synchronize them manually, outside of the settings
you set in the Colligo Engage Options dialog:

1. Click the Site menu to display the options:

() Colligo Engage Sync Panel

File | Site | Wiew Help

Synd 2]
Issu 'I
|

Manage Sites...
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2. Choose one of the following options:
o Synchronize Multiple Sites: select this option to display all sites and choose which ones you want
to synchronize
¢ Synchronize All: select this option to synchronize all sites
o Synchronize Pending Changes: select this option to synchronize any lists or libraries containing
changed content

Viewing Pending Changes

When you are not connected to your SharePoint server, any changes and edits you make to any items
are listed in the Pending Synchronization Changes dialog.

From the View menu, select View Pending Changes. The Pending Synchronization Changes dialog
displays any items that will be synchronized the next time you are connected to the network. You have
the option in this dialog to right-click an item and select discard if you want to revert the change.

Resolving Sync Issues

If you are editing an item offline and another user has made changes to the item on the SharePoint
server since your last synchronization, a Sync Issue is created during your next sync. The item is listed in
the Colligo Engage Sync Panel dialog:

r(t’ Colligo Engage Sync Panel | = | E &r
File 5Site View Help
Issue Item Site List Folder
< | o
((' Mo Synchronization Activity

4

To resolve the synchronization issue, double-click the line item. The Resolve Synchronization Conflict
dialog displays:
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Local Version

Document

StratMLFAQ20091027.doc
% Microsoft Word 97 - 2003 Document

=1 74.0 KB (75,776 bytes)

Microsoft Word

Folder

Colligo Engage Outlook App

Server Version
Document

StratMLFAQ20091027.doc
% Microsoft Word 97 - 2003 Document
=l 74.0KB (75,776 bytes)

Microsoft Word

Folder

|/

EY

Properties

Content Type: | Demo Document

Properties
Content Type: | Dema Document

Name *
StratMLFAQ20031027.doc
Title
StratMLFAQ20021027.doc

Correspondence List
Audio Visual

Market Sector

Defence + Justice + Custodial

Name *
StratMLFAQ20031027.doc
Title
StratMLFAQ20091027.doc

Correspondence List
Audio Visual

Market Sector

Defence + Justice + Custodial

Apply | | Revert

Last Update
Editor: Tessa Mackinnon
Modified: 07/09/2011 5:12:31 PM

Apply | | Revert

Last Update
Editor: Tessa Mackinnon
Modified: 07/09/2011 5:13:25 PM

This dialog allows you to choose either the local version that you have edited or the server version
that another user has changed. You can also click Merge Versions to see the changes in each
document and choose which changes you want to keep.
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EDITING CONTENT IN COLLIGO ENGAGE OUTLOOK APP

The actions available to you for editing content in Colligo Engage Outlook App depend on if the

SharePoint location has been set to upload-only or offline.

Editing Content in Upload-only Locations

Colligo Engage Outlook App

The actions available for items that are in upload-only locations are displayed in the drop-down menu for

each item:

Inbox Library Taols
Sent Items Site Actions - @2 Browse [EBRITUENS
Deleted Items 835 ﬂ ij Ly Check Out ] Version History £ )SendTo ~
- {5 CheckIn £ Document Permissions 5 Manage Copies
4 Colligo E New Upload  New Edit View _ Edit Emaila Alet Downloada W
RIICiENgRGE) Document - Document» Folder Document &, Discard Check Out  Froperties Properties < Delete Document Link Me~ Copy (5 Go To Source
Deleted Items New Open & Check Out Manage Share & Track Copies
Browser Sites [] Type  Name Modified
4 Favorites
Social 014 7
Marketing (frestertersharcpointe... | = o oo @ eriefings 10172014 7
Shared Documents (vs-sp2010) (2  2014-08-08_122044_Ben Henderson (Demo)_item 1 =5/26/2014 10|
Business Development
4 Folders @& 6 1 release_160ct2013 View Properties 2/11/2014 10|
I Graphics (firestarter.sharepaint.co... @) ACME Quote-Word 2003 [} edit Properties 5/7/2014 6:3
Marketing (firestarter.sh: . tbraries heck
arketing (firestarter.sharepoint.c... Check Out 4
— 3] camtasia [F) 14 11
Recavered Items T — G Desert Compliance Details jo/4/2014 4:3
Search Folders
Test B tghthouse Alert Ve 2/11/2014 10
Send To 4
[&  Stepan Arakelyan_11Marl4 14.59.20_RE Visio /1172014 3:
Lists (3  Tessa Mackinnon_11Feb14 10.47.45_send and file X Delete /11/2014 10|

Editing Content in Offline Locations

In offline locations, the actions available are more limited than upload-only locations. These actions are

displayed in the right-click menu for each item:

Edit Properties...
Egpen with Adobe Reader
Copy
Paste

Check Out

Wersion History

Send As Link

Send As Attachment

Copy SharePoint URL

Copy SharePoint Doc ID URL

Rename

Delete

Create Shortout

MName Maodified Madified By Author  Related Company  Person/Group  Prod
'@Firesbrher Pro Range datashee... 3/5/2014 4:02FM David Jackson Pro
=St 0 i David Jackson tHenzie E:
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MOVING OR COPYING EMAILS

You can move or copy email to a SharePoint location in four ways:

1. Dragging-and-dropping emails.

2. Using the Move and Copy buttons in the Colligo Engage group.

3. Using contextual menu options.

4. Using Send-and-File.
If you choose to move an email, there is no longer a copy of it in your Outlook account. If you choose
to copy an email, a copy is retained in your Outlook account. This behavior is determined in your
settings dialog; see Managing Settings.

The experience of filing items to SharePoint in Colligo Engage Outlook App is the same regardless of
whether you are connected to your SharePoint server.

When you are connected to the network, any items are uploaded to SharePoint immediately, unless you
have modified the sync options. When you are offline, new or modified items are uploaded to
SharePoint according to your Sync Options settings. See Synchronizing Content in Colligo Engage
Outlook App.

NOTE: Uploading items to SharePoint will not block you from using other Outlook functions.

Dragging and Dropping Email

When you drag-and-drop an email to a SharePoint folder, the default behavior is to create a copy of the
email in that location while retaining the original in your Outlook account. You can change this behavior
in the Settings dialog. See Managing Settings.

If your default behavior is set to Move, you have the option of doing a right-click drag-and-drop that
displays the following dialog, giving you the option to Copy:

@ Deleted Items

Browser
Favorites
4 [ 3 Folders
Ei Product Management [vs-sp2010.corporate.local)
4 Et Shared Documents (portal.colligo.com)
Et Briefings
C# phe Moye
CF spd . Is

53 Copy
[ Recove

LG search Cancel

NOTE: if you have a folder in your Folders list that has numerous subfolders that you have to scroll
through to find the folder to drag-and-drop your email into, it is easier to use the Move/Copy
buttons and use the filter feature to isolate the folder; see Using the Move and Copy Buttons.

To drag-and-drop an email to a SharePoint folder:

1. Select the email you want to move to a SharePoint location.
2. Click and drag the selected email to a folder in your Favorites or Folders list.

The Edit Properties dialog displays:
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( [y
(©) Edit Properties E@g

.Optiuns
Content Type: | Email -
-Properﬁes
Name Value ||
+ Name 010ct14 23.21.01_Djackson@firestarter.onmicre msg
Title Djacksen@firestarter.onmicrosoft.com
Subject Djacksen@firestarter.onmicrosoft.com
From Helen Jones £

From-Address

Sent 10/1/2014 1121 PM

Received [10/1/2014

To

To-Address

cC

CC-Address

BCC

BCC-Address &

| QK |[ Cancel l

3. Inthe Options section, choose the Content Type from the drop-down menu.

4. Inthe Properties section, modify the fields as preferred.
The property fields are inherited from the SharePoint library you are moving your email into. Most
SharePoint 2010 metadata is supported, including Enterprise Managed Metadata (taxonomies,
keywords). Email properties such as To, From, and Subject are automatically extracted. The Title field
auto-populates with the Subject of the email.

5. Click OK to complete the process.

NOTE: If you have enabled the Copied to SharePoint setting, the marker displays in the header of
the email and in the list view:

search Inbox [Ctri+B) | 6 Tips to Get Started with Automated Testing [Compli ary eBook]
Arrange By: Date (Conversations) MNewest on top i Goran Begic <info@smar‘tbearmail.com>
4 Earlier this Month Copied to SharePoint
Sent: Thu 2/28/2013 5:13 AM
[ MCIX's 48 Hour Super Sale! Huge savings on the.., ] - Archie Bunker
MCIX Newsletter 3/2/2013 -
-
To view this email 35 3 web page, click hers
4 Last Month L
] |4 6 Tips to Get Started with Automated Testing [C... 1]
Goran Begic 2/28/2013 | ’ 1
[4 NCIX's Bundle Up the Savings Event - $4.99 Ship... h | " TeStcomPIEte 3
MCIX Newsletter 2/28/2013 by SMARTBEAR
[ [no subject] ]
Bernard Cheng 2/27/2013
[ Get creative with your photos ] - - -
Windows 27212013 Six Tips to Get Started with Automated
[~ Your eBook: Automated Testing in Virtual Labs 1] H
SmartBear Software 2/26/2013 TEStI ng
[~ Automated Testing in Virtual Labs [Complimenta...
Goran Begic 2/26/2013 New SmartBear eBook! A T —
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To enable or disable this setting, see Managing Settings.

Using the Move and Copy Buttons

To move or copy an email to a SharePoint folder:
1. In Outlook, select the email you want to move or copy, or double-click it to display it in its own win-
dow. The Move and Copy buttons display in both views:

E lﬁ‘ " Search
) Colliga -
Maove Copy

- -

Colligo Engage

2. From the drop-down menu, choose the folder you want to move your email to:

ﬁ lF‘ # Search ;4 T

) Colligo~ .
Move Copy Move Rules On
Favaorites
E Marketing (firestarter.sharepoint.com)

Shared Documents (vs-sp2010)

. Other SharePoint Locations...

3. Ifthefolder you want is not in your Favorites or History list, select Other SharePoint Locations.

The Select Move/Copy Destination dialog displays:

=

-
{'f? Select Move Destination | Bl S

o Add Remove Edit (9]

Colligo Intranet

Select a list or folder as a valid destination

Cancel

NOTE: When you are offline, locations that are not set to upload-only are greyed out. If you want to
be able to file items to specific locations when offline, ensure that you set them as upload-only prior
to going offline.

4. Browse to the location of the folder or list you want to copy the email to.
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NOTE: If you are filing to a location that has not been set as upload-only, you can set it by double
clicking it. You cannot do this when you are offline.

5. Click OK. The Edit Properties dialog displays.

6. Choose your Content Type and enter the Properties as needed.
7. Click OK to complete the process.

NOTE: If you have enabled the Copied to SharePoint setting, the marker displays in the header of the
email and in the list view:

Search Inbox (Ctri+ ) #|| 6 Tips to Get Started with Automated Testing [Complimentary eBook]
. i £y . . .
Arrange By: Date (Conversations) Mewest on top Goran BEQIC <|nfo@5martbearmall.com>
4 Earlier this Month Copied to SharePoint
Thu 2/25/2013 5:13 AM
[-=d MNCIX's 43 Hour Super Sale! Huge savings on the... [ | Archie Bunker
MNCIX Newsletter 3/2/2013
-
To view this email as a web page, glick hers
4 Last Month N
. |_J 6Tipsto Get Started with Automated Testing [C.. B
Goran Begic 2/28/2013 | V.
(4 NCIX's Bundle Up the Savings Event - 54.99 Ship... 1 | ‘W TestCOmplete =
MCIX Newsletter 2/28/2013 ¥ SMARTBEAR
=4 [no subject) [ |
Bernard Cheng 2/27,/2013
|-—d Get creative with your photos [ ] - - -
Windows 22172013 Six Tips to Get Started with Automated
|-=] Your eBook: Automated Testing in Virtual Labs ] H
SmartBear Software 2/26/2013 TEStI n g
[=] Automated Testing in Virtual Labs [Complimenta...
Goran Begic 2/26/2013 Ne","-f qua-tBea- EBOO ,(' h

To enable or disable this setting, see Managing Settings.

Using Contextual Menu Options

To file emails to SharePoint using the contextual menu options:

1. Right-click an email and select Copy to SharePoint or Move to SharePoint from the contextual
menu:
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B H -
HOME SEND / RECEIVE
| [
El :’T‘E ;l_ilgnure x
Clean Up ~
Mew  MNew o Delete
Email ltems~ & lunk~
Mew Delete
4 Favorites
Inbox
Sent Items

Deleted temns 835

4 Colligo Engage
Deleted Items
Erowser
4 Favorites
Marketing (firestarter.sharepaint.c...
Shared Documents (vs-sp2010)
4 Folders
[- Graphics (firestarter.sharepaint.co...
Marketing (firestarter.sharepaint.c...
Recovered ltems

Search Folders

4 TMacKinnon@colligo.com

I Inbox
Drafts [4]
Sent Items

I Deleted Items 835

I Colligo For SharePoint
Conversation History
Junk E-Mail
Outbox
RSS Feeds

I Search Folders

FOLDER VIEW COLUGO LAUNCHPAD
:,j (’_\ t’;\a [2 Mesting Product Manag... Q-)To Manager [
- ¢ £ -
< =4 EJ Team Email v Done
Reply R;ﬁ"y Forward B More~ |2 Reply & Delete ¥ Create New =
Respaond Quick Steps [Fl
search Current Mailbox (Ctrl=E) £ | Current Mailbox ~ 2 Reply f@_
All Unread By Date ~  Mewest &
4 Today
colligo.com on Yammer [ |
Your Yammer activity for Thursday, Octob... 7:49 AM
colliga.com To Tessa Macki
We removed
I» Yesterday 6
4 Tuesday
Microsoft Online Services Team =
ion 7 ) T ar..  Tue®:18 PM
Copy
] Quick Print
Reply Im
Viewy G2 Reply Al lli..  9/19/2014
Your b
our £3 Forward !
P
Oider | =, Mark as Unread
Micr¢ W Categorize y m =3
REMEV all .. 8/20/2014
Your C |* Follow Up 4
Siene B Eind Related 3 =3
RE: Iny Quick Steps » 8/6/2014
Hella 1 les
‘= Rules 3
Bents Move N
Re: Ha TA12014
ot sul ¥y Copyto SharePoint » || Favorites 2
Ben H¥4 Move to SharePoint » Marketing (firestarter.sharepoint.com)
Re: S5p OneMote Shared Documents p2010)
candig
= lgnore pn  Other SharePoint Locations... ke
Berni o =3
>
RE: 5p WO unk " ho.. 62172018 "
Trytot X Delete >Happy Fri
- >

to any location in any of your sites.

The Edit Properties dialog displays.

3. Choose your Content Type and enter the Properties as needed.
4. Click OK to complete the process.

Colligo Engage Outlook App

2. Choose a location from your Favorites or History, or choose Other SharePoint Locations to browse

NOTE: If you have enabled the Copied to SharePoint setting, the marker displays in the header of
the email and in the list view:

Search Inbox [Ctri+E)

Arrange By: Date (Conversations)

4 Earlier this Month

MNCIX Newsletter

4 Last Month

1| 6 Tips to Get Started with Automated Testing [Complimentary eBook]

Newest on top

Goran Begic <info@smartbearmail.com >

Copied to SharePoint

Sent

= MCI¥'s 48 Hour Super Sale! Huge savings on the.., [ | Th

3/2/2013

|4 6 Tips to Get Started with Automated Testing [C... l

Thu 2/28/2013 5:13 AM
Archie Bunker

To view this email 35 3 web page. click hers

rrT—

2/25/2015

Goran Begic 2/28/2013 | l
[ NCIX's Bundle Up the Savings Event - 4.9 ship... [l b | " TeStcomPIEte
MNCIX Mewsletter 2/28/2013 by SMARTBEAR
L= [no subject) [ |
Bernard Cheng 2/27/2013
=4 Get creative with your photos [ | - - -
Windows 21013 Six Tips to Get Started with Automated
=4 Your eBook: Automated Testing in Virtual Labs ] H
SmartBear Software 2/26/2013 TEStI n g
[~ Automated Testing in Virtual Labs [Complimenta.
Goran Begic 2/26/2013 New SmartBear eBook!
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Moving or Copying Multiple Emails

To move or copy multiple emails:

1. Select your emails in Outlook (use Ctrl + click to select more than one email).

NOTE: If you select greater than 10 emails, a warning displays and you have the option to cancel. If you
select more than 50 the operation cannot be completed. These numbers are configurable in the
configuration settings.

2. In Outlook 2010 or 2013, click either the Move or Copy button in the Colligo Engage group on the
Home tab; in Outlook 2007, click the Move to SharePoint or Copy to SharePoint button in the Col-
ligo Engage toolbar.

3. Select the folder location that you are moving or copying the emails to.

The Edit Properties dialog displays:

{? Edit Properties =REC X
1 colligo.com on... -
Opt
1 Microsoft Onlin... o
Content Type: | Document
Properties
MName Value
= Name colligo.com on Yammer_020ct14 07.!
Title
1] | »
I CK I [ Cancel l

4. Inthe left pane, select the email and edit the Content Type and Properties as needed.

See Using Managed Metadata for information about metadata fields.

See Applying Metadata to Multiple Emails for information about applying metadata to multiple
items.

5. When metadata for all emails is complete, click OK.

The emails are moved or copied to the selected folder.

Sending and Filing Emails
When you are sending an email, you can choose the send-and-file option so the email is saved to a
SharePoint site at the same time as being sent to the recipient.
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3.
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When your email is complete and ready to send, click the Send & File button that displays in the
Message ribbon of a new email message.

Alist of your SharePoint Favorites and your most recently used SharePoint folders (History) displays:

==l | B
MESSAGE INSERT OPTIONS FORMAT TEXT REVIEW

»

Send & Attach  Paste
File ~ - -

Favorites Basic Text
Marketing (firestarter.sharepoint.corm)

Shared Documents (v

£ Other SharePoint Locations...
Subject

Choose a location in your Favorites or History list, or choose Other SharePoint locations to see all
your SharePoint sites.

The Edit Properties dialog displays.
Edit the Content Type and any Metadata fields as preferred.
See Using Managed Metadata for information about metadata fields.

Click OK to both send the email and file it to SharePoint.

NOTE: You can determine whether or not this action means that the email is copied or moved to the
SharePoint site by changing the Colligo Engage Outlook App settings. See Managing Settings.

Applying Metadata to Multiple Emails

You can apply the same metadata properties to multiple emails. However, the properties that are
available for group edit are the ones that are common to all selected upload items. Therefore, items that
are based on the same content type will have more common properties available for group edit than a
group of items that are based on different content types.

To apply the same metadata to multiple emails:

1. Select your emails in Outlook (use Ctrl + click to select more than one email).

2. In Outlook 2010, click either the Move or Copy button in the Colligo Engage group on the Home
tab; in Outlook 2007, click the Move to SharePoint or Copy to SharePoint button in the Colligo
Engage toolbar.

3. Select the folder location that you are moving or copying the emails to.

The Edit Properties dialog displays:
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{?_‘ Edit Properties

1 colligo.com on Yam... | [ ] . i
1 Microsaft Online Ser... | SIS Edit Enter property values to apply to the 2 selected upload items.

Options

Content Type: | Document

Properties

MName Value

+ Name

Title

n | »

I OK |[ Cancel l

e ~

4. Press the Ctrl key and click to select the emails in the left column that you want to apply the same
metadata to.

The metadata properties that are common to all selected items display. All metadata you enter is
applied to all selected emails:

NOTE: See Using Managed Metadata for information about metadata fields.

5. Edit the Content Type and Properties as needed.
6. When metadata for all emails is complete, click OK.

The emails are moved or copied to the selected folder.

Using Managed Metadata

Managed metadata is a set of hierarchical terms that you can use to classify items in SharePoint. The
terms are defined in the SharePoint site, and are available to you when you are filing emails.

To read more about managed metadata in SharePoint, please see:

http://technet.microsoft.com/en-us/library/ee424402.aspx

When you are entering metadata, you can use typeahead or select from the entire list of terms to make
the process more efficient, and you can add your own terms to a set of metadata.

Using Typeahead

If you are typing in a field that has managed metadata, a drop-down list of options displays when you
start typing the first few letters. You can then select from the list of options rather than typing in the rest
of the term.
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Cc-Address

Bcc-Address

Tags p| 44

Suggestions

Public Relations [Keywords]

0K | [ Cancel

Selecting from a List of Metadata

1. To seethe entire list of metadata available for a given field, click the icon to display a list of avail-
able terms to choose from.

The Select term(s) dialog displays:

rg Select term(s) Iglﬂlﬂ1

4 <F AssetlD
I < LanuageTest
I < Parks
) Search using features
I SWMP

| OK I[ Cancel ]

2. You can double-click a term to add it to the list of selected terms, or you can select the term and
click Select.
The terms you selected are now added to the related field.

3. Click OK.

Using Person or Group Metadata
You can assign person or group metadata when filing emails.

Depending on how your SharePoint document library was configured, you may have the following
options to:

e enter multiple people and/or groups
e choose people only or people and groups
e choose from all users or a group

Validating a Person or Group Name

To validate a person or group name:
1. Ifyou only know part of the name of a person or group, you can enter one or more letters in the

8/

The following error message displays:

field and click the validation icon
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Person Single

=

&

No exact match was found. Ciick the item(x) thar did not resolve for more options.

2. Click the item to display a drop-down menu of suggestions based

on the letter(s) you entered:

Person Single

Person and Group Sit

Person Multi

Person and Group M

Person Home Memb«

+ Person Required

Group Within Group

E More Names..

5 &
Suggestions item(s) that did mot resclve for mare options.

Ben Henderson =
Eill England &

Brad Wilde & o
Braeden Calyniuk

Brent Bolleman e
CORPORATE\ablock &
CORPORATE\gbunker &/ & L4
CORPORATE\zhoogensen

CORPORATE\barmyj @ .
CORPORATE\bbarker

None of the above | oK | [ Cancel l

Remaove

ﬁ

3. Select an item from the list to enter in the field, or enter new search letters.

Searching for a Person or Group Name

To search for a person or group name:

1. Click the address book icon to view the directory of your SharePoint people and groups. The
Search People dialog displays:

-
@,‘- Search People

ESREER™X)

Find

Display Mame

Email

start your search.

Account Name

Type into the search box above then press "Enter” to

Cancel

-

oy

2. Click the search icon to display a complete list of all people and groups, or enter a name in the
Find field and press Enter to search.
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3. Select the person or group you want to add to the field and click OK.
Filing Emails to a Drop-Off Library
You can drag-and-drop, send-and-file, move, or copy an email to a drop-off Library destination.

When you file an email to a drop-off library location, the following message displays in the Edit
Properties screen:

Content Organizer: Documents uploaded here are automatically mowved to the correct library
and folder after document properties are collected.
Options
Content Type: | Email -
Properties
Narme Walue 4|
= Name Bob Barker_030ct11 14.45.29_Terminal Services msg
Title Terminal Services i
To Bob Barl-:er|
Subject Terminal Services
From Dave Mackay
cC -
| OK | [ Cancel l

This message indicates that after the email is filed to the drop-off library, the related routing rules will
route the email to the appropriate location.

The upload dialog confirms that you have filed the email to the drop-off library:

Upload Progress M

Copying files to:
Dirop O Library (vs-dev-sp2010)

-1 David Jackson_060ct14 20.49.34_Document for app... &%

NOTE: If you file an email to a location that is a destination point of the drop-off library, Colligo Engage
Outlook App overrides the action and re-routes the email to the drop-off library itself, rather than the
destination. The reason for this is to ensure that the content is routed according to how the Content
Organizer has been configured to move content to the desired libraries.
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Managing Attachments in Emails
When you are sending an email, you have the option of inserting a link to a document location in
SharePoint, or inserting a SharePoint item as an attachment.
NOTE: this feature is currently available only when you are connected to your SharePoint server.
1. When you want to attach a document or insert a link, click the Attach button that displays in the
Message ribbon of a new email message.
Alist of your SharePoint Favorites and your most recently used SharePoint folders (History) displays:

E H =
IMESSAGE INSERT OPTIONS FORMAT TEXT REVIEW

5 Cut

Send & Attach  Paste

File = - - Format Painter

Colligo | Favaorites Basic Text
Marketing (firestarter.sharepoint.com)
E|j| Shared Documents (vs-sp2010)
send | bgy Other SharePoint Locations...
subjEct

2. Choose a location in your Favorites or History list, or choose Other SharePoint locations to see all
your SharePoint sites.
The Insert Attachment From SharePoint dialog displays:

7
(f_’ Insert Attachment From SharePoint = ] | S,
| Histcry| Favorites | Folders | Sites | 7 |
. . . Arrange By: Date | Newest on top
firestarter.sharepoint.com = Marketing
vs-sp2010 = Shared Documents
I Insert Item | I Insert Link | [ Cancel l
8 ¥,

3. You can find an item by accessing your History, Favorite, or Folder locations by clicking on the
appropriate tab, or see all of your SharePoint locations on the Sites tab. You can also use the Search

field to narrow the list.

NOTE: The number of items that display in the results pane when you select a folder location or
when you use the search feature, are set in the SharePoint Query Options field in the Search
Options tab (see Managing Search Options).
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4. Browse through either the search results or your folders and subfolders until you find the item you
are looking for. You can use the Arrange By toggle to arrange items by the Date the item was
created or by who created the item (From).

5. Choose one of the following options:

a. Insert Item: choose this option if you want to insert the item as an attachment
b. Insert Link: choose this option if you want to insert a link to the item's location in Share-

Point
6. Click Send or Send & File.

Copying an Outlook Folder to SharePoint
You can copy a folder from Outlook to a SharePoint location using Colligo Engage Outlook App.
NOTE: you can only copy folders to SharePoint; moving a folder is not available.

1. Right-click on the folder you want to copy to SharePoint and select Copy to SharePoint from the
contextual menu:

4 Inbox

E= Openin Mew Window
D Mew Folder...
i€ 1 Rename Folder
Copy Folder
Move Folder
q = Delete Folder
Recover Deleted Items...
b S MarkAll as Read
5 #=  Clean Up Folder

T3 Delete Al
T ) .
Show in Favorites
BT
W
Dri

Ser ¥ Move Down

[ Del Properties...

b Co Refresh
Cofr=: -
J_? Copy to SharePoint b || Favorites
Ju
o Mew Folder... Marketing (firestarter.sharepoint.com)
RSS Feeds Shared Documents (vs-sp2010)
I Search Folders f;n  Other SharePoint Locations...

2. Choose a location in your Favorites or History list, or choose Other SharePoint locations to see all
your SharePoint sites.

The Edit Properties dialog displays:
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-
(@,‘- Edit Properties
1 colligo.com on Yam... _ ] _ .
= Y TS | Group Edit: Enter property values to apply to the 2 selected upload items.
-Dptiu-ns
Content Type: | Document
lProperties
Narne Value
= Name
Title
P n | L
| OK | [ Cancel l
A >

For information about applying metadata to multiple emails, see Applying Metadata to Multiple

Emails.

Using Outlook Rules to File Emails
To use an Outlook rule to file an email:
1. In Outlook, you can use the Rules Wizard to define the properties of the email that will be filed by

therule.
2. To choose the SharePoint folder you want to file the email in, click the move it to the specified

folder link in Step 2 of the Rules Wizard:
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Rules Wizard ﬁ

Start from a template or from a blank rule
Step 1: Select a template

Stay Organized

B Move messages from someone to a folder

"
3

Move messages with specific words in the subject to a folder
Move messages sent to a public group to a folder
|"‘ Flag messages from someone for follow-up
¥ Move Microsoft InfoPath forms of a specific type to a folder
i Move RSS5 items from a specific RSS Feed to a folder
Stay Up to Date
Display mail from someone in the New Item Alert Window
«i Play a sound when I get messages from someane
@ Send an alert to my mobile device when I get messages from someone
Start from a blank rule
Apply rule on messages [receive
*=] Apply rule on messages I send

Step 2: Edit the rule description [click an underlined value]
Apply this rule after the message arrives
from people or public group
move it to the specified folder
and stop processing more rules

Example: Move mail from my manager to my High Importance folder

<Back [ nNeds | [ Finish

The Rules and Alerts dialog displays:

=

Rules and Alerts

Choose a folder:
4 E Colligo Engage

[5] Deleted Items
&y Browser Cancel
> Favorites
> Folders
Recovered Items
TMacKinnon@colligo.com

: |&, Public Folders - TMacKinnon@colligo.co

i g

. €2

4 [l | »

Colligo Engage Outlook App

3. Browse to your preferred SharePoint folder in the Colligo Engage group.
4. Click OK.
5. Edit the remaining elements of the rule description in the wizard and click Finish.

All emails that meet the criteria of the rule are filed to the SharePoint location you selected; however,
the Edit Properties dialog displays so you can edit the metadata for each email.

Using Outlook Quick Steps to File Emails

To use Quick Steps to file emails:
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1. Inthe Quick Steps group on the Home ribbon, click Create New:

Preduct Manag... 3 To Manager
ET Team Email v Done
(2 Reply & Delete -
Quick Steps ]

The Edit Quick Step dialog displays:
T Name:
My Quick Step

Add actions below that will be performed when this quick step is dicked on.

ctons

Choose an Action

Shortcutkey: | Choose a shortcut lz‘

Tooltip text:  This text will show up when the mouse hovers over the quick step.

2. In the Name field, enter a name for the Quick Step.
3. Under the Choose an Action drop-down menu, in the Filing group, choose Move to folder or Copy
to folder as preferred.

After you have chosen the Filing action, the Choose folder menu displays on the Edit Quick Step
dialog.

4. Choose Other Folder from the drop-down menu.
The Select Folder dialog displays:
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=

Select Folder

Folders:

] E Colligo Engage

(= Deleted Items

I} Browser Cancel
Fawvorites
Falders

Recovered Items

i g

L "

5. Choose a folder from the Colligo Engage group and click OK.
6. Click Finish.

You can file emails to the SharePoint location you chose by selecting an email in Outlook and clicking
the Quick Step you created in the Quick Steps group.

The Edit Properties dialog displays so you can edit the metadata for each email.
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MANAGING SETTINGS

To manage your settings:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Settings.

The Settings dialog displays:

(? Colligo Engage Configuration @
SharePoint Sites = Settings
Favorites History
Folders . )
MNumber of History itemns: 10

Search Locations

SEE e Drag-and-Drop Behavior | |Send—and-FiIe Behavior
Launchpad @ Copy to SharePaint @ Copy to SharePaint
Settings _) Move to SharePoint ) Move to SharePoint

Mark Copied Emails with Label and Color

© Enabled  Label: Copied to SharePoint N - |
_) Disabled

View SharePoint content in:

_) Qutlook View

@ Browser and Offline View

Lagging

Log level: | Maormal hd

Log file: Open log file location

Close |

e J

3. Inthe History section, enter the maximum number of items you want to display in the History list
(number must be between five and 50).
4. In the Drag-and-Drop Behavior and the Send-and-File Behavior sections, choose one of the fol-
lowing options:
o Copy to SharePoint: choose this option if you want to retain a copy of the email in Outlook
as well as filing a copy in SharePoint
e Move to SharePoint: choose this option if you want to move the email to SharePoint with-
out retaining a copy in Outlook

NOTE: If you choose the Move to SharePoint option as the default behavior, you have the
option to right-click and drag one or more items into a destination folder, and a contextual
menu displays, giving you the option to Copy OR Move the item.
5. Inthe Mark Copied Emails with Label and Color section, choose from the following options:
o Enabled: if this setting is enabled, the text in the Label field displays in the header of any
email that has been copied to SharePoint
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o Disabled: if this setting is disabled, there is no indication in the header of an email header
that has been copied to SharePoint
e Label: The default text in the label field is Copied to SharePoint; enter a new label if pre-
ferred
e Color: Choose an Outlook color category from the drop-down menu for the label to display
in
NOTE: this label is automatically applied to any items filed when offline.

6. Inthe View SharePoint content in section, choose from the following options:

e Outlook View: Choose this option if you want to display the content of the Share-
Point location as an Outlook folder view with a preview pane (see Viewing Upload-
only Locations)

e Browser and Offline View: Choose this option if you want to display the content of
the SharePoint location as either upload-only or offline (see Viewing Upload-only
Locations)

7. The Logging section allows you to set the level of detail you want to have in your error log files.
These log files assist Colligo technical staff in solving any issues that may arise while using Colligo
Engage Outlook App.In the Logging section, select the preferred option from the Log level drop-
down menu:

o Off: select this option if you don’t want to log any information about any activity errors or
warnings
o Normal: select this option to log information about activity, errors, and warnings
NOTE: this is the default logging level

o Verbose: select this option to include more detail about activity, errors, and warnings
o Verbose with Web Services: select this option to include the most detailed level of infor-
mation about activity, errors, and warnings

NOTE: choosing this option creates a very large log file and may slow the performance of
your system

8. The Logging section allows you to set the level of detail you want to have in your error log files.
These log files assist Colligo technical staff in solving any issues that may arise while using Colligo
Engage Outlook App. Click Open log file location to access the log files.
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CONFIGURING LAUNCHPAD

NOTE: The Launchpad feature only functions when you are connected to your network.

Launchpad is a ribbon in Outlook where you can create groups that contain buttons linking to your most
frequently used web pages and web applications for quick access from within Outlook. Once you have
buttons you can choose to add related items underneath it, as shown in the below image:

Folder View Calligo Colligo Launchpad F
O | e DS
ep arepoin ite Inta
| UsDept | CRM Sh int Elit pp
of Justice = Favorites =
= Legal resources epoint sites Billing Applicafions
Legal forms

Iterm Group

Launchpad

NOTE: Launchpad is not available in Outlook 2007.

To configure the Launchpad ribbon:

1. Inthe Colligo Engage group on the Home tab, click the Colligo drop-down arrow and select Con-
figure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Launchpad.

OR

From the Launchpad ribbon, click the Launchpad icon to display the configuration dialog:

= Marketing (firestarter.sharepoin
HOME SEND / RECEIVE FOLDER VIEW COLLIGO LAUNCHPAD

Launchpad Favorites

-

Colligo

The Launchpad dialog displays:
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re ™y
(c;,‘- Colligo Engage Configuration ﬂ
SharePoint Sites n Launchpad
Favorites o Add Remove [# Edit|7.7 Display Favorites _:’H‘;Import _4&:Export
Folders
4 LAUNCHPAD
Search Locations 7.4 Engage Favorites

Search Options
Launchpad

Settings

Close

o >,

Editing the Launchpad Tab

To edit the name of the Launchpad tab:
1. Select Launchpad and click Edit.
The Edit Launchpad dialog displays:

s '
() Edit Launchpad =
Title: launcHPAD
Screen Tip:
Description:
I Ok | [ Cancel ]
e ”,

2. Edit the Title field.

3. Enter Screen Tip text and a Description if needed.

4. Click OK.

5. Restart Outlook for the change to take effect.
Adding a Group
To create a group in Launchpad:

1. Select Launchpad and click Add.

The Add Group dialog displays:
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5.
Adding a Button to a Group

(P_. Add Group

Title:
Sereen Tip:

Description:

Mew Group

[ OK ][Canr_el |

”

In the Title field, enter the name of the group.
Enter Screen Tip text and a Description if needed.

Click OK.

Restart Outlook for the change to take effect.

Once you have added a group, you can add a button to it:

1. Select the group that you want to add the button to and click Add.
The Add Button dialog displays:

4.
5.
6.

Adding an Item to a Button

€ Add Button

=

Title:
URL:

Icon:

Screen Tip:

Description:

"\I ew Button

Eru:-wsel

[ OK ] [ Cancel |

’

In the Title field, enter the name of the button.
In the URL field, enter the address of the web page or web application. After you enter the URL and
click away from the field, the icon associated with the URL displays in the Icon space. If you want to
change theicon, click Browse to choose your preferred icon. If you click Clear, the default icon

above s used.
Enter Screen Tip text and a Description if needed.

Click OK.

Restart Outlook for the change to take effect.

Once you have added a button, you can add one or more items to it:
1. Select the button that you want to add the item to and click Add.

The Add Item dialog displays:
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(@) Addtem =)
Title: MNew Item
URL:
Icon:
Browse
Screen Tip:
Description:
[ OK I[Cancel |

&

2. IntheTitle field, enter the name of the item.

3. Inthe URLfield, enter the address of the web page or web application.After you enter the URL and
click away from the field, the icon associated with the URL displays in the Icon space. If you want to
change theicon, click Browse to choose your preferred icon. If you click Clear, the default icon

above is used.

NOTE: this is a required field. You cannot create an item without a URL.

1. Enter Screen Tip text and a Description if needed.

2. Click OK.

3. Restart Outlook for the change to take effect.

Displaying Colligo Engage Outlook App Favorites

Colligo Engage Outlook App

If you have added SharePoint locations to your Colligo Engage Favorites list, you can also choose to
display them in the Launchpad ribbon.

1. Click the Display Favorites button in the Launchpad dialog:

>
(? Colligo Engage Configuration

SharePoint Sites
Favorites

Folders

Search Locations
Search Options
Launchpad

Settings

(] Launchpad

| o Add s Remove _/‘Editl}“gDisplay Favor‘itesl

4 |AUNCHPAD
7.0 Engage Favorites
4 [Z] New Group
|:| Mew Button

2. Restart Outlook for the change to take effect.

NOTE: This button is a toggle. To remove the Favorites group from the Launchpad ribbon, click the
button again and restart Outlook.

The SharePoint locations from your Favorites list do not display in the Launchpad dialog; they
display in the Launchpad ribbon in a group called Favorites:
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HOME SEND / RECEIVE FOLDER VIEW COLLGO
Launchpad Faworites
Colli 3 Marketing (firestarter.sharepoint.com)
4 Favorite 3% Shared Documents (vs-sp2010) Mailbox [CErl+E)

Viewing Launchpad URLs

After you have configured your groups, buttons, and items, they display on the Launchpad tab in

Outlook:

¥

HOME

©

Launchpad Favarites

Colligo

SEMD / RECEIVE

© ©

Mews Entertainment

Mews Ent

FOLDER

VIEW

COLLIGO

LAUNCHPAD

Click on any button or item to display its associated URL. If you move to another tab in Outlook, you
can click the Browser icon in the folder tree to go back to the last page you viewed.

You can use the refresh icon and the browser buttons in the navigation bar to navigate through the

web page.

B oS-

HOME SEND / RECEIVE FOLDER VIEW COLUGO LAUNCHPAD
Launchpad Favorites  Mews Entertainment
Colligo News Ent ~
<
4 Fayorites &=
Inbox

Sent Items

Deleted Items 835

Video World U.S. Africa Asia Latin America Middle East  Business Entertainment  Tech

Europe

4 Colligo Engage World Sport

Deleted Iterns

Browser | Dctober 3, 2014 — Updated D121 GMT (0021 HKT Ma

(ool ; e, [0][e W Scenesfrom the field - Hong Kong - Ebola - ISIS . Pluto a planet? - Supercars - Kelly Slater - 35,000 walruses

4 Favarites
Marketing (firestarter.sharepoint.c...
Shared Documents (vs-sp2010)

I Folders

PR i e

ADLERTISEMENT

FOLLOW US
G {72m| | w Follow @c

BREAKING NEWS

STOAFPOGETTY IMAGES

| Recovered Items

Search Folders

BT

Importing and Exporting Launchpad Settings

You can export your Launchpad settings and save it as a .ribbon file on your computer. You can then
import this file to another installation of Colligo Engage Outlook App.

NOTE: The Colligo Engage Favorites list is not exported.
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To export a Launchpad configuration file:
1. Inthe Launchpad configuration dialog, click the Export button.

s N
@, Colligo Engage Configuration ﬂ
SharePoint Sites K Launchpad
Favorites @ Add Remove [# Edit 7.7 Display Favorites _:’EImportl _@ Export |
Folders
4  LAUNCHPAD
Search Locations 74 Engage Favorites
Search Options 4 [E] News 80 Ent
El |:| Mews
Launchpad EI CNN
Settings F] |:| Entertainment
El Yahoo

A Windows Save As dialog displays.

2. Enter a name for the file and browse to the location where you want to save it.
3. Click Save.
To import a Launchpad configuration file:

1. Inthe Launchpad configuration dialog, click the Import button.

‘. R
(f:,- Colligo Engage Configuration ﬂ
SharePoint Sites K Launchpad
Faverites | o Add Remove [l# Edit|i'ﬁ? Display Favorites I‘_{.';Import [ Export |
Folders
4 LAUNCHPAD
Search Locations 70 Engage Favorites
Search Options “ @ News & Ent
4 l:l Mews
Launchpad EI NN
Settings 4 [ Entertainment

—

A Windows Open dialog displays.

2. Browse to the location of the saved .ribbon file.
3. Click Open. The Launchpad groups, buttons, and items display in the dialog.
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SEARCHING SHAREPOINT AND OUTLOOK

NOTE: This feature requires a network connection.

Colligo Engage Outlook App provides advanced search functionality, allowing you to search within
specific SharePoint sites and your Outlook account. You can use this to search for email or documents
that you or others have uploaded to SharePoint, or for items in your Outlook mailbox.

NOTE: When you upload an item to SharePoint, it is available immediately within the SharePoint site.
However, the item will not be returned in a search until the item has been indexed by a SharePoint
crawler. The timing and frequency of the crawls are set by your administrator.

Enabling Search Capability

To enable search functionality in Outlook 2010, click the Search button in the Colligo Engage group on
the Home tab; in Outlook 2007, click the Show/Hide Search Pane button in the Colligo Engage toolbar:

; |$“ + Search
] F=iN .
i) Colligo -
Move Copy

- -

Colligo Engage

A search pane displays along the right side of your Outlook main window. You can move the search
pane to any location in your Outlook window and it stays in that location the next time you start
Outlook.

Colligo M
| sl

Enter crifena fo seanch ShareFoint.

Searching

You can perform both basic and advanced searches using Colligo Engage Outlook App’s search function.

A basic search means you type a keyword and the search returns anything that matches that word,
regardless of the occurrence of that word.

An advanced search means you are searching specific metadata fields, using the same syntax you would
use in an Outlook search. You type the name of the metadata field you want to search, followed by a
colon, followed by the term you are searching for. You can enter multiple search terms in this format.

For example, a search with the parameters to:John subject:manual means you are searching the
metadata fields to and subject for the terms John and manual. Any results returned from the search will
meet both of these search criteria. The searchable metadata fields are configured by your systems
administrator. Custom metadata is also supported.
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After you have entered a search term and started the search, you can look at the progress of the search
by clicking the arrow at the bottom of the search pane:

* [t >
. ltems: 8 Locations: 2 in progress, 1
completed

The search locations display. You can click Cancel to remove results from a particular site from the
search.

colligo

Arrange By: Date Mewest on top

4 532012
[w]? Demol

Colligo and SharePoint Solves Rem

¢ fam | b
ltems: & Locations: 3 in progress, 1
completed

/" Colligo Team Site (Colligo”
Retrieving search meta

data... (0 item(s) found)

F ]

/" JBDema (JEDema)
Performing search... (0
item(=) found)

/" Briefcase (Briefcase)

Search complete (8 item(s) found)

/" Colligo Team Site (Caolligo”
F‘erf:-r*riﬂg search... (0
item(=) found)

Defining Search Locations and Terms

To define your search locations and parameters:
1. Enteryour search term in the search field.
2. Click the drop-down arrow to manage your search locations and options:

Search Locations
Search Options

3. Select Search Locations to select the location(s) you want to search in. For more information, see
Managing Search Locations.

4. Select Search Options to define your search options. For more information, see Managing Search
Options.

5. Click the search icon to begin the search.
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[+ ltems: 202 Locations: 1 completed. 1 complete with warning

Colligo * X
| test 2o
Arrange By: Date Newest on top
4 28/06/2011
(W]} Corporate'Bcheng 117 PM —
Mew Microsoft Office Word Document.doox
| Corporate\Echeng 757 PM
Bernard Cheng_28Jlunll 08.44.01_testmsg
| Corporate\Echeng 346 PM
Bernard Cheng_28Jlunll 08.44.01_testmsg
Corporate\Bcheng 339 PM
andom_test_dochd
()] Corporate\Bcheng 339PM +

NOTE: If you are not getting any search results it is likely because the search capability for the
SharePoint site has not been configured. Please contact your systems administrator.

Viewing Search Results

You can arrange your search results by item Date or Author (From). To toggle between these views, click

on the Arrange By field in the results pane and select Date or From:

v Date
From

You can also sort the results by viewing the newest item on top or the oldest item on top. To toggle
between these views, click the top-right corner of the search results to get the view you want:

[+ Items: 202 Locations: 1 completed, 1 complete with warning

| test o
Arrange By: Date QOldest on top
4 01/04/2007 =
[l Corporate’\Barryj 12:00 PM
B's Beverages, Inc. Projec ts
4 059/03,/2010
Iul Corporate\Ahoogensen 12:50 AM
Test Document.docx
] Corporate\Ahoogensen 12:52 AM
"~ Test DocumentZ.docx
] Corporate\Ahoogensen 12:54 AM
" Test Document3.docx
(@]} Corporate\Ahoogensen 12:59 AM
Test22.docx

Additionally,if an email with an attachment is returned in your search results, the paperclip icon displays

to indicate the attachment:
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Caolligo - X

| invoice] Al

if-‘-.rr:mge By: Date | Mewest on top

4 Today
] Dave MackKay [ 9:51 AM

[ % VRSl WU ¥ I
Hachment for Invoic

~ L= AT LT A

Managing Search Results

You can open and view items that display in your search results, as well as create a new email with a link
to the SharePoint item.

Use the x icon to clear the search term and search results:

Collige - X

colligo | b 4 |C||

Viewing an Iltem
To view an item in your search results, either double-click it to open and view, or right-click and select
Open from the contextual menu:

4 Colligo Technical Support
-~ Collige Technical Support

m

FW: Bug Open ager
Send As Link
4 Corporal  Send As Attachment
-] Corporatl Copy SharePoint Link

Emailing a Link to an Item
To email a link to an item in your search results, right-click the item and select Send As Link from the
contextual menu. This opens up a new email with a link to the item's location in SharePoint.

You can also drag-and-drop the item into your Inbox for the same result.

If you have an item in your search results that is an email with an attachment, you can open the email,
then drag-and-drop the attachment into your inbox; this opens up a new email with the attachment
attached. The subject line of the email defaults to the name of the attached file.

Sending Item as an Attachment

To send the item as an attachment, right-click the item and select Send As Attachment from the
contextual menu. This launches a new email with the search result item in the Attached field.
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Creating a Link to an Item

To copy the link to the item’s location in SharePoint, right-click the item and select Copy SharePoint Link
from the contextual menu. You can then paste the link into an email or document as needed.

Managing Search Locations

Any SharePoint site that you add to Colligo Engage Outlook App is added to your search locations list by
default. You can remove a site from the list to reduce the scope of a search, but then add it back at a later
time for another search.

Adding a Search Location
You can add a site to your search locations list in one of two ways:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthesite list, click the site you want to add to your search locations and click the Add Search Loca-

tion icon: .

A small magnifying glass icon appears at the end of the site name, indicating it is included in your
search locations list.

Colligo Intranet
4 Firestarter Portal
Marketing
Sales

E}Finance

E_j Form Templates
&

E_j Manufacturing

m Marketing 7.7 [ »

E_j Sales

E_j Site Assets

E_j Social

E_j Style Library

OR

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Search Locations.

The Search Locations dialog displays:
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SharePoint Sites
Favorites

Folders

Search Locations
Search Options
Launchpad

Settings

/- Search Locations

/éAdd /& Remove

Add Search Location

Close |

3. Click the Add Search Location link or the Add icon.

The Add Search Location dialog displays:

(C) Add Search Location EElm
Colligo Intranet
Firestarter Portal
Please select a location to search from
Cancel |

.

A

4. Select the site you want to add to the search list and click OK.

The site is now included in your search locations list.

Removing a Search Location

To remove a site from your search locations list:

Colligo Engage Outlook App

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in

Outlook 2007, click the Colligo drop-down arrow and select Configure.

2. Intheleft-hand pane of the Colligo Engage Configuration dialog, select Search Locations.
3. Inthesite list, click the site you want to remove and click Remove. The site no longer displays in the

list.
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Managing Search Options
The Search Options area of Colligo Engage Outlook App lets you define your search parameters. To
define the search options:

1. Inthe Colligo Engage group on the Home tab in Outlook 2010 or 2013, or, in the Colligo Toolbar in
Outlook 2007, click the Colligo drop-down arrow and select Configure.
2. Inthe left-hand pane of the Colligo Engage Configuration dialog, select Search Options.

The Search Options dialog displays.

© Colligo Engage Configuration [éJ
SharePaint Sites / Search Options
Favorites Outlook
Folders Search all mail items
Search Locations Search Qutlook Inbax

Search Options Limit results to: 200

Launchpad SharePoint Query Options
Settings Limit results to: 200
Search On
Files and Folders @ Files Only ) Folders Only

@ All Files ) Filter Files

ype Extension

B 0 = =B R

Close |
J

3. Inthe Outlook section of the dialog,choose your parameters:
a. Check the Search all mail items box if you want to search your Inbox as well as all other fold-
ers in your default mailbox. The following folders are not included in the search: Junk E-Mail,
Deleted Items, Public Folders, and RSS Feeds. If you have more than one email address
linked to Outlook, Colligo Engage Outlook App searches only the default account.
b. Check the Search Outlook Inbox box if you want to limit the search to your inbox content.
c. Inthe Limit results to field, enter the number of results you want returned per folder.
4. Inthe SharePoint Query Options section, enter the results number in the Limit Results to field.
5. Inthe Search On section, choose your parameters:

a. Choose from one of the following:
a. Files and Folders
b. Files Only
c. Folders Only
b. Ifyou choose either the Files and Folders or Files Only option, you can further
determine the file types you want to search by choosing one of the following:
a. All Files
b. Filter Files
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c. Ifyou choose Filter Files you can further define the type of files you are searching by
checking the boxes of the file types in the list.

Custom Search Folders

Custom search folders are functionality native to Outlook and are separate from Colligo’s search
capability. A custom search only searches within Outlook, whereas a Colligo Engage Outlook App search
includes both your Outlook account as well as your SharePoint sites.
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UNINSTALLING COLLIGO ENGAGE OUTLOOK APP

To uninstallColligo Engage Outlook App:

1. Inyour Control Panel, choose Uninstall a Program from the Programs group.
2. Select theColligo Engage in the program list and click Uninstall.
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